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1. Lwu y quan trong

S tay st dung dién t& nay danh cho moi
nguw®i dung str dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay truéc khi sir dung man hinh. Sé tay
bao gébm nhirng théng tin va cac lvu y
quan trong lién quan dén viéc st dung
man hinh.

Ché dd bao hanh cta Philips ap dung voi
diéu kién la san phadm phai dwoc st dung
dung cach theo muc dich str dung, theo
cac hwdng dan hoat déng clng vai viéc
xuét trinh héa don gbc hoéac bién nhan
tién mat ghi rd ngay mua, t&n ngudi ban,
mau ma va ma sb san xuat ctia sdn pham.

1.1 Lwu y an toan va bao dwéng

) Canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay co thé
khién nguoi dung dé bi dién giat, gap cac
rdi ro vé dién va/hodc co hoc.

Hay doc va thwc hién theo cac hwéng dan
sau khi két ndi va sir dung man hinh may
tinh.

Hoat dong

« Hay dat man hinh & khu vyc khéong cé
anh sang truc tiép clia mat, anh sang
riec co cwong dé6 manh va cach xa
bat ky ngudn nhiét nao khac. Bat man
hinh lau ngay trong méi tredng nay cé
thé khién cho man hinh bj bac mau va
hong.

« Di chuyén moi dé vat c6 thé roi vao
cac 16 thdng gid cla man hinh hodc
ngan can qua trinh lam mat thich hop
cla cac thiét bj dién tlr bén trong man
hinh.

« Khong bit kin cac 16 thdng gi6 trén vo
man hinh.

Dam bao d&t man hinh & gan noi co6
phich c&m va 6 cadm dién.

Né&u t&t man hinh bang cach rut cap
ngudn hodc day dién DC, hay doi 6
giay trwde khi cdm cap ngudn hoac
day dién DC dé man hinh hoat déng
binh thwdng.

Hay luén dung cap ngudn chuan dwoc
cap bdi Philips. Néu thiéu cap nguén,
hay lién hé v&i trung tadm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tam théng tin tiéu dung
cham soc khach hang)

Khéng dat man hinh & noi bi chan
doéng hay va cham manh khi dang
hoat dong.

Khéng dap hoac lam roi man hinh khi
dang hoat dong hodc khi di chuyén.

Bao dwéng

DPé& man hinh khéng bi héng, khéong dé
nén qua manh lén mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chét
khung man hinh dé nhéc 1én; khéng

nhac man hinh bang cach dat ban tay
hoac ngon tay 1én mat man hinh LCD.

Rut phich cdm man hinh néu ban
khéng dinh str dung né trong thoi gian
dai.

Rut phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng

vai hoi wét. Ban c6 thé lau man hinh
béng vai kho khi da ngét dién. Tuy
nhién, dirng bao gi& dung dung maoi
hiru co, chang han nhw cén hodc cac
chét 1dng cé ngudn gbc tlr amoniac dé
lau man hinh.

Pé tranh nguy co b dién giat hoac
héng vinh vién bé man hinh, khéng
dat man hinh & noi cé bui, mwa, nwéc
hodc & noi qua am wot.

Néu man hinh bj wét, hay lau né bang
vai khd cang sém cang tét.

Néu chéat la hodc nwdc dinh vao man
hinh, hay ngat dién ngay va rat cap
nguén. Sau d6 lau sach chét la hodc



nuwdc rdi glri man hinh dén trung tam
bao dwdng.

« Khéng cét giir hodc st dung man hinh
& noi c6 ngudn nhiét, anh nang truc
tiép hodc qua lanh.

« P& duy tri hoat ddng t6i wu ctia man
hinh va s&r dung né trong th&i gian dai,
hay dung man hinh & noi ndm trong
gi¢i han nhiét d6 va dd 4m sau.

« Nhiét dé: 0-40°C 32-95°F
- D06 &m: 20-80% RH

« LUU Y: Ludn bat trinh bdo vé man
hinh chuyé&n déng khi ban khéng st
dung man hinh. Luén bat irng dung
lam m&i man hinh dinh ky, néu khong,
man hinh cda ban sé& hién thj nhirng
ndi dung tinh khoéng thay dbi. Hién thi
lién tuc cac anh tinh trong mét thoi
gian dai c6 thé gay ra hién twong “anh
thtr ndng”, con dwoc goi la “anh ao”
hay “anh bong ma”, trén man hinh cua
ban.

«  “Anh thtr néng”, “Anh 30" hay “Anh
bong ma” la hién twong phd bién trong
céng nghé& man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thtr ndng” hoac “anh ao” hay “anh
bong ma” sé dan dan bién mét sau
mot thdi gian man hinh bi ngét dién.

) Canh bao

Khéng thé kich hoat trinh bao vé man hinh
hoac rng dung nap lai man hinh dinh ky
c6 thé gay ra cac sy ¢b nghiém trong nhw
“thtr ndng” hoac “anh sau” hoac “anh boéng
ma” vén sé& khéng biét mat va ciing khéng
thé khac phuc. Thiét hai nhu trén khéng
nam trong chinh sach bao hanh cta ching
toi.

Dich vu

* Chi nhan vién dich vu chuyén mén
ma&i dwoc m& vo boc man hinh.

« Né&u can moi tai liéu hwéng dan dé
stra chira hoac tich hgp man hinh,
hay lién hé v&i trung tam dich vu tai

dia phwong ban. (vui long tham khao
chwong "Trung tam théng tin tiéu
dung")

- P& biét thdng tin vé viéc van chuyén,
vui long tham khao muc "Théng so ky
thuat".

* Khoéng dat man hinh trong xe hoi/lcdp
xe dwéi anh nang trwc tiép.

& Ghicha

Hay tham khao y kién cua ky thuat vién
dich vu néu man hinh khéng hoat ddng
binh thuwérng hodc néu ban khéng chéc
phai thwc hién quy trinh nao khi da lam
theo cac hwéng dan hoat ddng néu trong
sb tay nay.



1. Lwu y quan tron

1.2 Mb ta biéu twong

Cac muc phu sau day mo ta cac quy woéc
ve biéu twgng dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bo sb tay nay, cac doan chiy
c6 thé di kém biéu twong va dwoc in dam
ho&c in nghiéng. Cac doan nay bao goém
cac ghi chu, lwu y hoac canh bao. Chung
dwoc st dung nhu sau:

& Ghicha

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét giup ban tan
dung t6t hé théng may tinh.

O Luuy

Biéu twong nay cho biét cac théng tin gitp
ban biét cach tranh dwoc sw cd hdng héc
tiém an dbi véi phan cirng hodc méat div
liéu.

) Canh bao

Biéu twong nay cho biét sw tn thuong
co thé tiém 4n va gitp ban biét cach tranh
dwoc sy cd do.

Mot s6 canh bao c6 thé xuét hién & nhiéu
dinh dang va cé thé khéng di kém mot
biéu twong. Trong nhirng trwéng hop nay,
céach thirc trinh bay cu thé clia canh bao
do dwgc quy dinh b&i co quan chirc nang
lién quan.



1.3 Vit bé san pham va vat liéu
dong goi
Thiét bj dién & dién t&r bi vt b3-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste. You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping

off such waste electrical and electronic,
contact your local government office, the
waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that

can be recycled and reused. Specialized
companies can recycle your product to
increase the amount of reusable materials and
to minimize the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make
the packaging easily separable into mono
materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and
economically viable objectives to optimize
the environmental performance of the
organization's product, service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled.
At Philips, end-of-life management primarily
entails participation in national take-back
initiatives and recycling programs whenever
possible, preferably in cooperation with
competitors, which recycle all materials
(products and related packaging material)

in accordance with all Environmental Laws
and taking back program with the contractor
company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http:/Aww.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai dat man hinh

2.1 Lap dat
E} Néi dung géi hang

_ %%art
M PHILIPS

Adapter‘AC/DC .
(dién xoay chiéu/mdt chieu)

MHL (tuy chon)

Cap am thanh(tuy chon)
(\
Tay @’
HDMI (tuy chon)

\~ E | P
VGA (tuy chon)

Quan ly cap DVI (tuy chon)

& Ghi chu

Chi nén sr dung mau adapter AC/DC:
Philips ADPC1965(284E5QSD/QSWI/
QHSD/QHAD)

N Warnings

Do not rip off panel film

El Lap chan dé
1. Dat man hinh ndm sép trén bé mat
A . R ~ R 3 by A
mém min, can than dé tranh lam tray
xwédc hoac hédng man hinh.

2. Gitr chan dé man hinh bang ca hai tay
va lap chat chan dé vao tru de.
(1) Gén nhe chan dé vao tru dé cho
dén khi chét cai khép chat vao
chéan dé.

(2) Dung ngon tay van chat dinh vit
nam & phia dwdi chan de va siet
chat chan dé vao tru deé.




El Két ndi véi PC
284E5QSD,284E5QSW:

PHILIPS

@ Dau vao ngudn dién AC/DC
© Dau vao VGA

© Diu vao DVI-D

O Khoda chdng trom Kensington

284E5QHAD :

PHILIPS

@ Dau vao ngudn dién AC/DC
© Diu vao VGA

© Diu vao HDMI

@O Dau vao HDMI hodc MHL
© Dau ra tai nghe

O Dau vao am thanh

@ Khoa chdng trom Kensington

284E5QHSD:

PHILIPS

@ Dau vao ngudn dién AC/DC
@ Dbiu vao VGA

© Dbau vao HDMI

@ Diu vao HDMI hodc MHL
© Dau ra am thanh HDMI

O Khoda chdng trom Kensington

Két néi véi PC

1. C&m chéat cap ngudn vao mat sau cla
man hinh.

2. Tat may tinh va rat cap ngudn.

3. Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. C&m cap ngudn cla may tinh va cap
nguon cdia man hinh vao 6 cam dién
gan doé.

5. Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.




2.2 Sty dung man hinh

El Mo ta mat trwdc cha san pham
284E5QSD,284E5QSW,284E5QHSD:

BAT va TAT ngudn man
hinh.

e
C;

Truy nhap menu OSD.
= /0K Xac nhan diéu chinh menu
OSD.

4 |Tré vé mrc OSD trudec.

Déi dinh dang hién thi.

A V¥V Chinh menu OSD.

®@©00 ©
H

© |DPbi ngudn vao tin hiéu.

Smartimage Lite. C6 ba
ché dé dé ban lwa chon:
Standard (Chuén), Internet,
Game.

[
S|

284E5QHAD :

(5]

/4 ®/Y /A s/ok O

| | | | | |
6 O (4 (2 (1

BAT va TAT ngudn man
hinh.

(-
C;

Truy nhap menu OSD.
&= /0K | Xac nhan diéu chinh menu
OSD.

4 |Tr& vé mic OSD trudec.

Chinh am Iwvong loa.

A V¥V [Chinh menu OSD.

®©@ 60600 O

© |Dbi ngudn vao tin hiéu.

Smartimage Lite. C6 ba
ché do dé ban Iwa chon:
Standard (Chuén), Internet,
Game.

©®
S|




El M6 ta menu Hién thj trén man hinh
Hién thi trén man hinh (OSD) la gi?
Hién thj trén man hinh (OSD) |a mét tinh
nang cé & moi man hinh LCD cua Philips.
N6 cho phép ngwéi dung dieu chinh hoat
déng ctia man hinh hoac qhon cac chure
nang cda man hinh triec tiep théng qua
mot ctra s& hwéng dan hién thij trén man
hinh. Mot giao dién hién thi trén man hinh
dé st dung dwoc thé hién nhw sau:

284E5QSD,284E5QSW:

Picture
Colort

Language

0SD Settingg

MHL-HDMI
Picture

Audid

Colon

Language

Hwéng dan co ban va don gian vé cac
nut diéu khién

Trong menu OSD minh hoa & trén, ban cé
thé nhan v A cac nut & g& mat trwdc cla
man hinh dé di chuyén con tré va nhan nat
OK dé xac nhan Iwa chon hodc thay dbi.

Menu OSD

Dwéi day la tbng quan vé co ciu cua
menu Hién thi trén man hinh. Ban cé thé
st dung co ciu nay lam théng tin tham
khao khi muén thwe hién cac diéu chinh
khac sau nay.

Main menu Sub menu
— Input — VGA
— DVI (available for selective models)

— HDMI (available for selective models)

—— MHL-HDMI (available for selective models)

— Picture — Picture Format ——  Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartResponse —— Off, Fast, Faster, Fastest
(available for selective models)
+— SmartContrast — On, Off
— Gamma — 1.8,2.0,22,24,2.6
(available for selective models)
— Pixel Orbiting — On, Off
(available for selective models)
+— Over Scan — On, Off
L (available for selective models)
— Volume — 0~100
— Audio (available for selective models)
— Mute — On, Off
L Audio Source — Audioln/HDMI
(available for selective models)
I Color — Color Temperature =~ — 500K, 9300K
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Deutsch, Espafiol, EMnvikr, Frangais,

Italiano, Maryar, Nederlands, Portugués,
Portugués do Brazil, Polski, Pycckuii Svenska,
Suomi, Tirkge, Ce§tina, VKpaiHcbKa, Bk,
SRR, BAGE, $el

— OSD Settings —— Horizontal — 0~100
— Vertical — 0~100
[ Transparency — Off,1,2,3,4
— OSD Time Out — 5s, 10s, 20s, 30s, 60s
“— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Théng bao vé dd phan giai

Man hinh nay duoc thiét ké dé hoat
dong t6i wu voi do phan giai gbc la
1920x1080@60Hz. Khi dwoc chinh sang
dé phan giai khac, man hinh sé hién thi
mét théng bao: Use 1920x1080@60Hz
for best results. (Hay dung dé phan giai
1920x1080@60Hz dé co két qua tbi wu.)

Ban c6 thé tat thdng bao hién thi d6 phan
giai goc tr muc Cai dat trong menu OSD
(Hién thj trén man hinh).

B3 Tinh nang vat ly
Nghiéng




2.3 Thao dé va chan dé 4. N&i néng bbn vit dé thao tru d& ra

El Thao chan dé

Trwdce khi bat dau thao chan dé man

hinh, hay thwc hién theo cac hwdng dan

bén dwdi dé tranh moi thiét hai hay chan

thwong co thé xay ra.

1. DPat man hinh ndm sip trén bé mat
min, can than dé tranh lam tray xwédc
hoac hédng man hinh.

& Ghi chu
Man hinh nay chap nhan giao dién 1ap dat
tuan tht chuan VESA 100mm x 100mm.
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2.4 Gi®i thiéu vé MHL (Lién két
D6 nét Cao Di dong)

K} bay la chirc nang gi?

Lién két D6 nét Cao Di ddong (MHL) la giao
dién am thanh/video di ddng dé két ndi
trwc tiép dién thoai di dong va nhirng thiét
bi di ddng khac v&i cac man hinh dé nét
cao.

Céap MHL tuy chon cho phép ban chi can
két ndi thiét bi di ddong twong thich MHL
v&i man hinh I&n MHL Philips nay, va xem
céac video HD giébng nhw that véi am thanh
ky thuat s6 hoan chinh. Gi&» ban khéng chi
cé thé tan hwéng cac game di déng, anh
chup, phim, hoac cac ng dung khac trén
man hinh I&n cda Philips ma con c6 thé
sac pin déng thoi cho thiét bj di dong dé
ban khoéng bao gi®» hét pin gitra chirng.

F1 Lam thé nao dé str dung chirc ning
MHL?

DPé st dung chirc nang MHL, ban can cé
thiét bi di ddng dwoc chirng nhan twong
thich MHL. Dé tim danh sach cac thiét bi
dwoc chirng nhan twong thich MHL, hay
truy cap trang web MHL chinh thirc (http://
www.mhlconsortium.org)

Ban cling can cé cap tuy chon dac biét
dwoc chirng nhan twong thich MHL dé st
dung chtrc nang nay.

El Chirc nang nay hoat dong nhw thé
nao? (cach két néi?)

Hay cam cap MHL tuy chon vao céng USB
mini trén canh thiét bj di ddng va cbng
dwoc danh ddu [MHL-HDMI] trén canh
man hinh. Gi& ban sén sang xem cac hinh
anh trén man hinh I&n ctia minh va thwc
hién moi chirc ndng trén thiét bi di déng
nhw lwét web, choi game, duyét xem anh
chup, v.v... Néu man hinh c6 chirc ndng
loa, thi ban ciing c6 thé nghe am thanh
kém theo. Khi ngat két ndi cap MHL hoéac
tat thiét bj di dong, thi chirc nang MHL
ciing sé tw dong tat theo

11

PHILIPS =

® wapoosy | MHL-HDMI
T~ )

© Ghi chu

« Cbng dwoc danh dau [MHL-HDMI] la
cbng duy nhat trén man hinh vén hd
tro' chirc nang MHL khi sir dung cap
MHL. Lwu y rang cap dwoc chirng
nhan twong thich MHL sé khac so voi
cap HDMI chuén.

* Ban phai mua riéng thiét bi di déng
dwoc chirng nhan twong thich MHL

« Ban c6 thé phai chuyén man hinh
theo cach thi cong sang ché dd MHL-
HDMI @é kich hoat man hinh néu cé
nhirng thiét bi khac dang sén sang
hoat dong va duoc két ndi véi cac dau
Va0 ¢o san

« Ché d6 cho/Tat tiét kiém nang lwong
ErP khdéng ap dung cho chirc nang sac
pin MHL

« Man hinh Philips nay dwgc chirng
nhan twong thich MHL. Tuy nhién,
trong tredng hop thiét bi MHL cla ban
khong két nbi hodc hoat dong thich
hop, hay kiém tra phan Héi Bap vé
thiét bi MHL hoac lién hé truc tiép voi
nha cung cip dé dwoc huéng dan.
Chinh sach clia nha san xuéat thiét bj
clia ban co thé yéu cau ban mua cap
hoac adapter MHL riéng mang thuong
hiéu clia ho dé c6 thé sir dung thich
hop.



3. Toi wu héa hinh anh

3.1 Smartlmage Lite

Kl bolagi?

Smartlmage Lite cung cép cac chirc nang
cai dat san giup ban téi wu héa man hinh
dé st dung cho cac kiéu néi dung khac
nhau, linh hoat chinh d6 sang, d6 twong
phan, mau sac va do sic nét khi sir dung
thwe té. Du lam viéc véi cac ting dung
bang chir, hién thi hinh anh hay xem
video, Philips Smartimage Lite cling mang
lai cho ban hiéu qua man hinh téi wu nhét.

El Sao t6i phai can né?

Ban muén mét man hinh hién thi tbi wu
moi kiéu ndi dung wa thich, phan mém
Smartlmage Lite sé linh hoat chinh d6
sang, do twong phan, mau sac va do sac
nét khi str dung thwc t& nham nang cao
trai nghiém xem man hinh cua ban.

E} Cach hoat déng?

Smartlmage Lite 1a cdng nghé doc quyén
tién tién cda Philips vén sé phan tich cac
ndi dung hién thi trém man hinh cta ban.
Dwa trén bdi canh s&r dung ma ban lua
chon, Smartlmage Lite sé linh hoat cai tién
doé twong phan, bdo hda mau sac va do
s&c nét clia hinh anh dé cai thién néi dung
dang hién thj - tAt ca khi s dung thuc té
chi v&i duy nhat mét ci nhan nut.

3 Cach bat chirc nang Smartimage Lite?

ED

|

1. Nhan BED dé khéi dong Smartimage
Lite trén man hinh;
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2. Tiép tuc nhan BD dé chuyén gitra
Standard (Chuén), Internet, Game.

3. Menu OSD Smartimage Lite sé van
hién thi trén man hinh trong 5 giay
hodc ban cling c6 thé nhdn OK dé xac
nhan Iwa chon.

4. Khi Smartlmage Lite & dwoc bat, bd
cuc sRGB sé t dong tat. Bé dung
sRGB, ban phal tat Smartlmage Lite
bang nuat ik go mat trwdc ciia man
hinh.

Néu khong dung nut B dé cudn xuong,
ban cling co thé nhan cac nut v a dé chon
va nhan nut OK dé xac nhan lwa chon va
dong menu OSD Smartimage Lite.

Co ba ché do dé ban Iwa chon: Standard
(Chuan), Internet va Game.

@ SmartImage™

Internet

Game

e Standard (Chuan) Lam ré chir va
giam do sang giup ban dé doc chi va
b&t méi méat. Ché do nay tang dang ké
sy rd rang cua noi dung chir va hiéu
suat khi ban lam viéc véi cac bang
tinh, file PDF, cac bai muc scan hodc
cac rng dung van phong khac noi
chung.

 Internet: CAu hinh nay két hop béo
hoa mau séc, linh hoat tang do tuwong
phan va s&c nét dé hién thi anh chup
va cac hinh anh khac véi dd ré ndi bat
cung mau sac song dong - tat ca moi
thé» ma khéng hé co dau vét ctia mau
sac nhat va gia tao.

« Game: Tang mach truyén dong dé co
thoi gian dap tng toi wu, giam cac
bo' 1€ gai goéc cho cac ddi twong di
chuyén nhanh trén man hinh, tang do
twong phan cho bb cuc sang va toi,
cau hinh nay mang lai cho nguoi choi

trai nghiém choi game tét nhét.



3.2 SmartContrast

B bélagi?

Cong nghé doc dao von linh hoat phan
tich n6i dung hién thi va tw dong toi wu
hoa ty 1é twong phan cla man hinh LCD
dé mang lai do rd nét va trai nghiém xem
t6i wu, tang mirc dén nén dé hién thi
nhung hinh anh sang ré hon, sac nét hon
va song dong hon hay giam mirc dén nén
dé hién thj rd hinh anh trén phéng nén téi.

El Sao t6i phai can n6?

Ban muédn hién thj ndi dung ré nét cung
cam giac thoai mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chmh
dd twong phan va mirc dén nén dé hién
thi nhikng hinh anh choi game hay video
cire ro, song dong va sac nét hay hien thi
ndi dung ch r6 rang de doc cho cac tng
dung van phong. Bang cach giam viéc tiéu
thu dién cua man hinh, ban sé tiét klem
dwoc chi phi nang ILPo’ng va kéo dai tudi
tho cho man hinh cuta ban.

E} Cach hoat dong?

Khi ban bat ché do SmartContrast, n6 sé
phan tlch noi dung dang hién thi trong
thuc té dé chinh mau sac va mat do den
nén. Chtrc nang nay sé linh hoat tang
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét voi khi xem video
hoac choi game.

3.3 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i clia
Philips cho phép ban diéu khién man hinh
qua giao dién do hoa 3o tién dung. Cac
dieu chinh phtrc tap la nhirng gi thudc vé
qua khir vi phan mém than thién véi ngudi
dung nay sé hwdng dan ban qua viéc tly
chinh d6 phan giai, hiéu chinh mau, diéu
chinh ddng hd/gdc pha, diéu chinh diém
trdng RGB (Pd-Luc-Lam), v.v

Trang bi cdng nghé mai nhét vé thuat toan
16i xt ly va phan (rng nhanh, phdn mém
chay bang anh ddng bat mat thwong thich
v&i Windows 7 nay sén sang nang cao trai
nghiém cla ban vé&i man hinh Philips!
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K} Caidat ]

» Thwc hién theo chi dan va hoan tat
quy trinh cai dat.

 Ban c6 thé kh&i dong phdn mém sau
khi hoan tat cai dat.

«  Néu mubn khéi dong sau, ban c6 thé
click phim tat phan mém trén man
hinh nén hoac thanh céng cu may
tinh.

PHILIPS

Venuindex.html 0 dawnload the latest version of SmartContral

Thuat si khéi dong 1an dau

« Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé tw dong vao
Thuat si khéi dong lan dau.

« Thuat sT nay sé hwdng dan ban thdng
qua viéc dieu chinh tirng bwéc vé hiéu
suat man hinh.

« Sau nay ban ciing c6 thé vao menu
Plug-in (Bb sung) dé bat thuat sf.

« Ban c6 thé chinh céac tuy chon khac
qua giao dién Standard (Chuan) ma
khoéng can thuat si.

B St Cartral T

SmartControl Lite PHILIPS

Wizard




z
r - ~ >

El Khéi dong bang giao Standard (dién

Chuén):

Menu Adjust (Diéu chinh):

Menu Adjust (Diéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (D6 twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (B phan giai).
Ban c6 thé lam theo chi dan va thuc
hién diéu chinh.
Lénh Cancel (Hly) sé héi nguwdi dung
xem ho c6 mubn huy tién trinh cai dat
hay khéng.

W souaCantol T

SmartControl Lite PHILIPS

RArighiness

Impraperly adjusted Brightness wil result n 2 loss of
datad n darker image areas. Adwust the Brightnass for
the best possbia picture quaity.

ower the Brightness to the mnsmum level

2. Raie the Brightness to the desred level

3. Adjust tha Brightness zs needed to achieve
an equal separation of the sripes

Brightrivs

Undo Reser

EQ; &i %C

W St Control d} _)_(..

SmartControl Lite PHILIPS

Contrast

®

Unida Rasat

E Resolumion
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B SmanContiol

SmartControl Lite

W St Contiol

(9}

Bnghtness

SmartControl Lite

B SmantContol

Resolumion

SmartControl Lite

=
>
o

(9}

Bnghtness

Ex
PHILIPS

Focus

Your display’s timng needs to be smchronzed with
the wdeo sgnal.

1. thoose Auto Setup.

2. I the vertical bands are stil visble, vou'l need

o adjust the Pitch.

Pitch: Try to meke the vertical bands deappear.
Phase: Adjust to the brightest settng to minkmze
movement on the screen.

17
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Unda Auto Setup

Bz
PHILIPS

Position

FE3)
PHILIPS

Resolution

You are curently 3t 2 Preferred resolibon. For your
deply to show arso, dear test, cobors, and mages,
vour display should be set to s Preferred resohiton.
I your display Is 2t 2 Mon-Preferred resolution, dick
on the Preferred button to change your resolition to
Preferred.

™ Enabie Resolution Motfier

Picture Fi it

M
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Menu Color (Mau):

Menu Color (Mau) cho phép ban chinh
mau RGB (Doé-Luc-Lam), Black Level
(Do téi), White Point (Diém trang),
Color Calibration (Hiéu chinh mau) va
Smartlmage Lite (Vui long tham khao
muc Smartlmage Lite).

Ban co thé lam theo chi dan va thyc
hién diéu chinh.

Tham thao bang bén dudi dé hinh
dung co ban vé muc menu phu trén
thong tin nhap cda ban.

Vi du Color Calibration (Hiéu chinh
mau sac):

W St Control

FieS
PHILIPS

SmartControl Lite

Black Level

=

Adjust RGA
T TF
@ Grea 50
Color White Pont =] - *
S E‘ Rhint 50
\g iy G - +
|
‘,pm ca%or Ur-n.o Reser
ap
\g Smartimage
fo
W St Control Fix
SmartControl Lite PHILIPS

White Point

Adjust RGA
\g Diack Lavel
Colar mgpm
.y - White Poit GS00K
" Display Gamma = nd
W)
. unda Reset
Options calbration e — \ — e —
. ap
Srrarthrage

Hlp

W St Contiol T

SmartControl Lite PHILIPS

Display Gamma

To adiust Gamma, Smartimage
Cick the ¥ button

=

Adjust RGA

Use ider to select the desred Gamma
\g K.
Color \-_»,-,g.,‘,,._t Disotay Gamima 22
: & &
\g Mﬂﬁ,;m
|
Options Ca%or Undo Reser
ap
\g Smartimage
e
B SmantContol Fx
SmartControl Lite PHILIPS

Calibration

Iu qualty frst.
Adjust BGE 2. Press Show Me to leam how to use the
calibration took.
\g Black Levef
Color White Pont
Display Gamma
Qptions Galbration
il
. L
\’ Serurt hruge
Hep
Show Me Start
Quick View

1. "Show Me" (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

2. Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 budéc.

3. Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

4. Tré& vé giao dién chinh Color (Mau),
click nut Cancel (Huy).

5. Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khéng dwoc phép hiéu chinh mau va
tat cac nat khéi déng va xem nhanh.

6. Phai co thong tin bang sang ché trén
man hinh hiéu chinh.
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Man hinh hiéu chinh mau dau tién:

« Nut Previous (Trwéc) sé tat cho dén
khi man hinh mau th& hai bat Ién.

» Next (Ké tiép) sé chuyén vao muc tiéu
tiep theo (6 muc tiéu).

« K& tiép cubi cung sé vao giao dién
File>Presets (File>Cai san).

* Nut Cancel (Huy) sé dong giao dién
ngw&i dung (Ul) va tré ve trang Plug-
in (b sung).

Smartimage Lite

Cho phép nguoi dung thay doi cai dat dé

dat mirc cai dat man hinh tét hon dwa vao

ndi dung.

Khi da cai dat Entertainment (Giai tri), tinh

hang SmartContrast va SmartResponse

Sé tat.

W souaCantol 2%
SmartControl Lite PHILIPS

SmartImane

Color wh
. ™ D |g? ¥
-y
Optans Calbration
ap
- =
Hulp
] &
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Options>Preferences (Tuy chon>Uu tién)
- Sé chi hoat déng khi chon Preferences
(UJu tién) tr menu Options (Tuy chon) s
xudng. Trén man hinh khéng hé tro twong
thich v&i chudn DDC/CI, chi c6 sén cac
thé Help (Tro giup) va Options (Tuy chon).

W St Contiol Il‘..

SmartControl Lite PHILIPS

Preferences

NOt

§

Help

« Hién thj cac cai dat wu tién hién hanh.
« O vira chon sé bat tinh nang nay. O
chon la nat bat/tat.

« Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Menu
Enable Context (Bat thudc tinh) hién
thi cac lwa chon SmartControl Lite cho
Select Preset (Chon cai san) va Tune
Display (Chinh man hinh) trong menu
thudc tinh khi click phai vao man
hinh nén. Disabled (D3 tét) sé& x6a
SmartControl Lite khéi menu thudc
tinh click phai.

« Biéu twong Enable Task Tray (Bat

khay tac vu) dwoc chon la (Bat) theo
mac dinh. Enable Context Menu
(Menu bat thudc tinh) hién thi menu
khay tac vu cho SmartControl Lite.
Click phai vao biéu twong khay tac

vu sé& hién thj cac ty chon menu cho
Help (Tro giup), Technical Support
(H6 tror k¥ thuat), Check for Update
(Kiém tra cap nhat), About (Vé) va Exit
(Thoat). Khi da tat Enable task tray



menu (Menu bat khay tac vu), biéu
tu’o’ng’khay tac vu sé chi hién thj EXIT
(THOAT).

» Theo mac dinh Run at Startup (Chay
khi kh&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khoéng
bat khi kh&i déng hodc nam trong
khay tac vu. Cach duy nhéat dé bat
SmartControl Lite |a to phim tat trén
man hinh nén hoéc ti file chwong
trinh. B4t ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khoéng tai khi 6 nay khéng dwoc chon
(Da tat).

« Enable transparency mode (Bat ché
do trong subt) (Windows 7, Vista, XP).
Mac dinh 1a 0% M&.

Options>Input (Tuay chon>Nhap) - Sé chi

hoat dong khi chon Input (Nhap) tr menu

Options (Tuy chon) s xudng. Trén man

hinh khéng hé tro twong thich véi chuan

DDC/CI, chi c6 san cac thé Help (Tro

gilip) va Options (Tuy chon). Tat ca cac

thé SmartControl Lite khac déu khéng cé
san.

B SmantControl Fx

SmartControl Lite PHILIPS

Input

Adjust

Presats

Anziog In Diral in

« Hién thi giao dién hwéng dan Source
(Ngudn) va cai dat nguon nhap théng
tin hién hanh.

« Trén cac man hinh nhap riéng, giao
dién nay sé khéng hién thi.
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Options>Audio (Tuy chon>Am thanh)
- S& chi hoat ddng khi chon Audio (Am
thanh) tir menu Options (Tuy chon) sb
xudng.

Trén man hinh khéng hé tro twong thich
v&i chuan DDC/CI, chi cé san cac thé Help
(Tro giup) va Options (Tuy chon).

W St Contiol T

SmartControl Lite PHILIPS

Audio

Unda.

Help>User Manual (Tro’ giup>Sé tay st
dung) - Sé chi hoat déng khi chon User
Manual (Sé tay st dung) tr menu Help
(Tro giup) s6 xudng. Trén man hinh khéng
hd tro twong thich véi chuan DDC/CI, chi
cd san cac thé Help (Tro giup) va Options
(Tuy chon).
W SevtCuntial 2 %

SmartControl Lite PHILIPS

User Manual

Support



Help>Version (Tro’ giup>Phién ban) -

Sé chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé trg twong thich
v&i chuan DDC/CI, chi cé sén cac thé Help
(Tro giup) va Options (Tuy chon).

W St Contiol 7%

SmartControl Lite PHILIPS

Version

Dol
\_ Systam 1D
options
X'u‘
\ !g Vorsion
Help

Context Sensitive menu
(Menu nhay cam v¢&i thudc tinh)

Theo mac dinh, menu Context Sensitive
(Chinh theo thudc tinh) sé dwoc Bat. Néu
da chon menu Enable Context (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

SmatConteal  # i

— B8 SmartControl
Select Presst 3
Tune Dizplaor

smartlmage

The Context Menu (Menu thugc tinh) c6
bon muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thi.

+ Select Preset (Chon cai dat san) -
Cung cAp menu cac muc cai san da
lwu theo trinh tw dé sir dung ngay.
Déu kiém sé hién thi muc cai sén hién

dé chon. Muc Factory Preset (Cai sén
g@c) cling co6 thé dwoc chon tir menu
sO xuong.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

»  Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuan), Internet,
Game.

Da bat menu khay tac vu
Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite tw khay tac vu. Click trai
sé bat rng dung.
Help
Technical Support
Check For Update
About

Exik

Khay tac vu c6 nam muc nhéap:

* Help (Tro giup) - Truy cap file User
Manual (SO tay str dung): M¢& file User
Manual (S6 tay s&r dung) qua ctra sO
trinh duyét mac dinh.

»  Technical Support (H6 tro ky thuat) -
hién thi trang ho tro ky thuat.

* Check for Update (Kiém tra cap nhat)
- dan ngwoi dung dén Nén (rng dung
PDI va kiém tra phién ban ctia nguoi
dung so v&i phién ban cé sdn maoi
nhét.

«  About (V&) - Hién thj théng tin tham
khao chi tiét: phién ban san pham,
thong tin ve phién ban va tén san
pham.

« Exit (Thoat) - Bong SmartControl Lite.

pé chay lai SmartControl Lite, hay chon
SmartControl Lite tr menu Program
(Chwong trinh), click déi biéu twong PC
trén man hinh nén hodc kh&i déng lai hé
thdng.



PHILIPS

SmartControl

SmartControl
“ersion 3.20
chune-standard-R2007-01-04-1151-23
Copryright 1983-2007 Portrait Dieplays, Inc.
Patents Pending

Pa tat menu khay tac vu

Khi da tat Khay tac vu trong thw muc

wu tién, chi con cd san lwa chon EXIT
(THOAT). Bé& x6a hoan toan SmartControl
Lite khdi khay tac vu, hay tat Run at
Startup (Chay khi khéi dong) trong
Options>Preferences (Tuy chon>Uu tién).

%quy

T4t ca cac hinh minh hoa trong phan
nay chi dwoc dung dé tham khao. Chung
t6i c6 thé thay dbi phién ban phan mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cap trang web
chinh thirc cta Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé phién
ban phan mém SmartControl méi nhét.
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4. Cac théng so ky thuat

Loai mat man hinh TFT(AMVA)

DPén nén LED

C& man hinh Réng 28 inch (71,1cm)
Hé sb co 16:9

D6 pixel 0,32 x 0,32 mm

D6 sang 300 cd/m?
SmartContrast 20.000.000:1

Do twong phan (chuén) 3000:1

Thoi gian dap ng (chuén) 6.5 ms (mili giay)
Phan &ng thong minh

SmartReiponsg = 1175 (€1

D6 phan giai tbi wu 1920x1080 @ 60Hz
Goéc xem 176° (H)/ 176° (V) @ C/R> 10

Cai tién hinh anh

Smartlmage Lite

Mau man hinh

16,7 triéu mau

DPau vao tin hiéu

Tbc dd phat doc 56Hz - 76Hz
Tan sb ngang 30kHz - 83kHz
MHL 1080P@30Hz
sRGB (P&-Luc-Lam chuan) | CO

284E5QSD,284E5QSW: VGA (Analog), DVI (KTS
HDCP)

284E5QHAD ,284E5QHSD: VGA (Analog), HDMI (KTS
,HDCP), MHL-HDMI (KTS ,HDCP)

DAu ra/vao am thanh

284E5QHAD : Dau vao am thanh PC, dau ra tai nghe
284E5QHSD: Pau ra am thanh HDMI

Tin hiéu vao

DPdng bd riéng, Ddng bd vai tin hiéu xanh luc

Tién ich cho ngw&i dung

284E5QSD,284E5QSW,284E5QHSD:

ED/< /v /A /0K 0}
284E5QHAD :
ED/« /v /A /0K 0}

Ngén ngir OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Dtrc, Tiéng Tay Ban Nha, Tiéng Hy Lap,
Tiéng Phap, Tiéng Y, Tiéng Hungary, Tiéng Ha Lan, Tiéng
B& Pao Nha, Tiéng B6 Dao Nha Brazil, Tiéng Ba Lan,
Tiéng Nga, Tiéng Thuy Dién, Tiéng Phan Lan, Tiéng Tho
Nhi Ky, Tiéng Séc, Tiéng Ukrana, Tiéng Hoa gian thé,
Tiéng Hoa phon thé, Tiéng Nhat, Tiéng Han
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Tién ich khac

Khoa Kensington

Twong thich véi chun Plug
& Play (Cam vao la phat)

DDC/CI, sRGB, Windows 8/7/Vista/XP, Mac OSX, Linux

Nghiéng -5° [ +23°

284E5QSD,284E5QSW:
Ché do bat 31,5 W (chuan), 33,7 W (t6i da)
Ché d6 che (chuan) 0,5W
T4t (chuén) 0,3W
DPén bao LED nguén Ché do bat: Ché dé Trang, Ch&/Ngu: Trang (nhép nhay)
B6 ngudn Ngoai vi, 100-240VAC, 50-60Hz
284E5QHAD :
Ché d6 bat 32,65 W (chuan), 51,61 W (t6i da)
Ché d6 chd (chuan) 0,5W
Tat (chuén) 0,3W
DPén bao LED nguén Ché d6 bat: Ché dd Trang, Ch&/Ngu: Trang (nhap nhay)
Bo ngudn Ngoai vi, 100-240VAC, 50-60Hz
284E5QHSD:
Ché do bat 32,15 W (chuan), 33,7 W (t6i da)
Ché do6 ché (chuan) 0,5W
Tat (chuan) 0,3W
DPén bao LED nguén Ché do bat: Ché dé Trang, Ch&/Ngu: Trang (nhap nhay)
B6 ngudn Ngoai vi, 100-240VAC, 50-60Hz

San phadm kém theo dé gitr
(Réng x cao x day)

662.5 x 484.59 x 237 mm

San pham khong kém theo
dé gitr (Rong x cao x day)
Trong lwong

Sén pham kém theo dé giwr

662.5 x 389.59 x 58.54 mm

4,73 kg

San pham khéng kém theo
dé gitr

4,21 kg

Diéu kién hoat dong
Pham vi nhiét dé (hoat déng)

0°C-40°C

Gi®i han nhiét d6
(Khéng hoat déng)

-20°C - 60°C
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D6 4m twong doi 20% - 80%
MITIEE (e (Ui e 30.000 gi
binh gilra cac sy co)

Chi thi ROHS (Gi¢i han cac

chét gay hai) =

EPEAT Bac (www.epeat.net)

Thung dung C6 thé tai ché 100%

Cac chét cu thé Thung dwng 100% khéng chira PVC BFR

Ngbi sao nang lwvong CO

Phé chuan theo quv dinh CE Mark, FCC Class B, CU, SEMKO, TCO Certified,
quy dl ETL, BSMI, 1S09241-307

Vo6 ngoai

284E5QSW : Trang/284E5QSD, 284E5QHSD,

Mau 284E5QHAD: Mau den dé anh dao hoac cac tuy chon
mau khac nhw ap dung tai khu vyc ctia ban
L&p son ngoai Bong lang/Hoa van
& Ghichu

1. Vang hay bac EPEAT chi ¢6 hiéu lwc tai noi ma Philips da dang ky san pham. Hay truy
cap www.epeat.net dé biét {nh trang dang kw tai qudc gia cla ban.

N

D liéu nay chju sw thay déi ma khéng can théng bao trwédc. Truy cap www.philips.com/
support dé tai vé phién ban t& roi méi nhéat.
Thoi gian phan tng théng minh la gia tri tdi wu tlr cac thir nghiém GtG hoac GTG (BW).

w
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4.1 Ché do doé phan giai & cai
dat san

E Do phan giai toi da
1920x1080@60 Hz (dau vao analog)
1920x1080@60 Hz (dau vao KTS)

E1 Db phan giai khuyén dung
1920x1080@60 Hz (d4u vao KTS)

Tansd Do phangidi Tan sb doc

ngang (kHz) (Hz)
31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

63,89 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghi chu

Lwu y rang man hinh cla ban hoat

dong tét nhat & dd phan giai gbc
1920%1080@60Hz. D& co6 chat lwong hién
thj tét nhat, hay dung dd phan giai khuyén
nghi nay.
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5. Quan ly nguon dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh ¢6 thé tw dong giam
tiéu thu dién khi khéng sir dung. Néu phat
hién nhap tr ban phim, chudt hay thiét bj
nhap khac, man hinh sé "hoat déng" tw
dong. Bang sau day sé hién thi mie tiéu
thu dién va cach truyén tin hiéu cuda tinh
nang tiét kiém dién tw dong nay:

284E5QSD,284E5QSW:

Dinh nghia quan ly nguén dién

Chédd |\ 400 Dggg Pdng | Ngudn dién st | Mau dén
VESA nga.ng bd doc dung LED

31,5 W (chuén)

Hoat déng| BAT | Co Co 33.7 W (t4i da) Trang

) Tréng

Ngu TAT |Khéng|Khong| 0,5 W (chuén) (Nhap

nhay)

Tat TAT - - | 0,3W (chuan) TAT
284E5QHAD :

Dinh nghia quan ly nguon dién
Chédd |\ 400 Dggg Pbdng | Ngudn dién siv | Mau dén
VESA * |bo doc dung LED

ngang
32,65 W )
Hoat dong| BAT Co Co (chuan) Trang
51,61 W (tdi da)
) Trang
Ngu TAT |Khéng|Khéng| 0,5 W (chuén) (Nhép
nhay)
Tat TAT - - 0,3 W (chuén) TAT
284E5QHSD:

Dinh nghia quan ly nguon dién
Chédd |\ 400 Dggg Péng | Ngudn dién st | Mau dén
VESA *  |bd doc dung LED

ngang
32,15 W
Hoat dong| BAT | Co6 | Co (chuén) Tréng
33,7 W (tdi da)
) Tréng
Ngu TAT |Khéng|Khoéng| 0,5 W (chuén) (Nhap
nhay)
Tat TAT - - | 0,3W (chuan) TAT
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Cai dat sau day dwoc dung dé do mirc

tiéu thu dién trén man hinh.

Do phan giai gbc: 1920x1080

« Do twong phan: 50%

* D06 sang: 250 nit

* Nhiét d6 mau: 6500k voi kiéu mau
trang day du

& Ghichua

D@ liéu nay chju sy thay ddi ma khéng

can thdng bao trudec.



6. Thong tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery

B and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable [T - manufacture,
use and recycling of IT products
reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:
*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

e Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)




EPEAT

(Www.epeat.net)
Q The EPEAT (Electronic
W Product Environmental
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

»  EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

*  2006/95/EC (Low Voltage Directive).

« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing
organization on ISO9000 level.

« 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* GS EK1-2000:2013 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

« TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Thong tin quy dinh
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour
la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Clags A of EN 55022 (radivs of protection up to 30 meters). The ussr of the
device is obliged to take all staps necessary to remove sources of intarfarance o tala-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedenao, #2 spada do do ffidy A podis EN 55022,
spadd automaticky do tidy B podie EN 55022, Pro zafizen! zatazend do tFidy A (chranné
pésrmo 30m) podie EN 55022 platl nésledulicd. Dojde-l k rullenl telekormunikatnich nebo
Fnfich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rueni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd

kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIIEE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schidden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 7/0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy dinh
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

S EABERHS

REPEAR (RFES-RSREFABTENE) (HHMAPEARMROHS)
AT T AR TR SNEEEEYRATENERNEE

FRBERZ
B (F&HECRT)

tEAEYRETE
A SR aEEEMRSTE
i * A vk ERMEE | ZR-EM
(Pb) | (Ha) | (Cd) | (Cr6+) (PEB) (PBDE)
3 @) [e) [e) O O [e)
CRTERE x @ O [s] @ [e)
BRETRATE] X [@ @) O @ €]
AR AT X O [e] [e) € [e)
RRIERE x O O [e} O [s]
BREEESE | x e @ [s} € [e}
* 1 FRRRARAR IS ED M e MR R MR S0 A + INeRfE - BhEE - SERLERRE - ERHRE
O FFAAEE RN S A R o g B
CR TR s B SR AR R A AR RS T
X | R EA B R E A A A R
(& TEETSEAEAENRNERERGAL) SENERER | BR RS "Xt
HEUARHSENER (BT HRH4)

@ MR FHRR

AR IRIEIAIR (), R T E R~ T & HHASE
AEVIFEOTRIE LT RS TSR L5
MEZELE, B E R el P ERIZ R T E R
an NSNS RGN S A EO HAS ~ Wi
R B E AR -

hERERHERA
RIBREAM (BEFHNEGAEENZ) FETHFEAUTER

%g_@(cdm >1.05

5 145

HE TE GB 21520-2008
HAE X (E BB EEAPELENTAR ¢ http:/www.energylabel.gov.cn/

(EF &S E T mEARREESS) FERtE
WA

N T IR R RFHER - S AR L
P e A e A R TN E R R A S
T an[E A SERAM - RPH AL L B
A EZOA T HYEBA B GTFT Y g 2T [E] U s
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EU Energy Label

|

PHILIPS  wovuonm

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh man
hinh phang cua Philips

Philips ¢b gang cung cap cac sén pham
chét lwvong cao nhat. Chung t6i ap dung
mot sO quy trinh san xuat tién tién nhat_
trong Iinh vic va thwe hién quy trinh kiém
tra chat lwgng nghiém ngat. Tuy nhién,
céac 16i diém anh hay diém anh con trén
man hinh TFT dung trong cac man hinh
phang déi khi khong the tranh khoi. [Khdng
nha san xuét nao c6 thé dam bao rang
moi man hinh sé khéng c6 cac I6i diém
anh, nhung Philips dam bao rang bét ky
man hinh nao c6 mét sb 16i khong thé
chap nhan sé dwoc stra chira hoac thay
ma&i dwa vao chinh sach bao hanh Thong
béo nay gidi thich nhirng kiéu I6i diém anh
khac nhau va dinh nghia cac mic, 16i cb
thé chap nhan cho méi kiéu 16i. D& hwéng
dich vu stra chira hay thay_ thé theo chinh
sach bao hanh, sb lwong 16i diém anh trén
man hinh TFT phal vwot qua cac mure
chap nhan nay. Vi du, khong qua 0,0004%
diém anh con trén man hinh co thé bi 16i.
Ngoai ra, Philips tham con dat ra cac tiéu
chuan chat lwong cao hon cho mot s
kiéu hay két hop 16i diém anh vén dé nhin
thay hon cac kiéu 16i khac. Chinh sach
nay co hiéu lyc trén toan cau.

s A

subpixel

RGBSR

pixel

= /

Diém anh va diém anh con

Diém anh hay phan t& anh gém ba diém
anh con trong cac mau chinh do, luc va
lam. Nhiéu diém anh cung tao thanh hinh
anh. Khi moi diém anh con ctia mét diém
anh sang Ien ba diém anh con c6 mau
sac cung hién thi nhw mét diém anh trang
don 1&. Khi moi diém anh con téi me, ba

diém anh con c6 mau séc cung hién thi
nhw mot diém anh den don I&. Nhirng. két
hop diém anh_con sang va t6i khac hién
thi nhw cac diém anh don 1& tir nhirng
mau khac.

Cac kiéu 16i diém anh
Cac 16i diém anh va diém anh con hién
thi trén man hinh theo nhirng cach khac

nhau Co6 hai kiéu 16i diém anh va nhiéu I6i
diém anh con trong méi kiéu I6i.

Cac 16i cham sang

Cac 16i chdm sang hién thj dwdi dang cac
diém anh hay diém anh con vén luén sang
hay "bat". Nghia la moi cham sang la mot
diém anh con von ndi |én trén man hinh

khi man hinh hién thj kiéu hinh t6i me&. Co
céac kiéu 16i chdm sang.

4 N

o )
Mot diém anh con sang dé, luc hay lam.
- N

I C

N J
Hai diem anh con sang gan nhau:

- Bbé+Lam=Tim

- Bd + Luc =Vang

- Luc + Lam = Lyc lam (Lam nhat)

s A

- /

Ba diém anh con sang gan nhau (mot
diém anh trang).



& Ghi chu

Chém sang dd hay lam phai sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so V&
cac cham xung quanh.

Cac 16i cham den

Cac 16i chdm den hién thi dwoi dang cac
diém anh hay diém anh con vén luén téi
m& hay 'tat'. Nghia la méi cham t6i me 1a
mot diém anh con von ndi 1én trén man
hinh khi man hinh hién thj kiéu hinh sang.
Co cac kiéu 16i cham den.

- ~

4 I N

LOI CHAM SANG

Do gan cua cac 16i diém anh

Vi céc 16i diém anh va diém anh con cla
cung kiéu 16i védn gan véi mot kiéu 16i khac
c6 thé dé& nhin thy hon, Philips ciing néu
ré cac dung sai vé do gan cuda I6i diém
anh.

- ~

4 N

N /

- %

Dung sai 16i diém anh

DPé hwéng dich vu stra chiva hay thay

thé do céac 16i diém anh trong thoi han

bao hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
diém &nh con vuwot qua nhirng dung sai
néu trong cac bang sau.

MU'C CHAP NHAN

1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh tréng) 0
Khoang céach gitra hai 16i chdm sang* >15mm
Tbng sb 16i chAm sang ctia moi kiéu |6i 3

1 diém anh con t6i mo

LOI CHAM BEN MUrC CHAP NHAN

5 hoac it hon

2 diém anh con t6i m& gan nhau

2 hoac it hon

3 diém anh con tdi m& gan nhau

0

Khoang cach giira hai 16i chAm den*

>15mm

Téng sb 16i chAm den ctia moi kiéu 16i

5 hoac it hon

TONG SO LOI CHAM

Tbng sb 16i chAm sang hay den clia moi kiéu I6i

MUC CHAP NHAN
5 hoac it hon

& Ghi chu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm

2. Man hinh nay tuan tha chuén ISO 9241-307. (1S09241-307: Yéu cau, phan tich vé hiéu
nang va cac phuong phap kiém tra tuan tha cho man hinh dién tk)




7.2 Cham séc khach hang & Ché ddé bao hanh

Dé cé théng tin chi tiét vé chinh sach bao hanh va yéu cau hd tro thém dwoc ap dung cho
khu vwc cua ban, vui long truy cap website www.philips.com/support. Ban ciing c6 thé lién

hé v&i Trung tdm cham séc khach hang dia phwong cda Philips theo sé dién thoai dwdi

day.

Thong tin lién lac cho khu vec TAY AU:

Qubc gia

S6 BT dwong day
nong

Gia

Gi® hoat déng

Austria RTS +43 0810 000206 €007 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 € 0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge |Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff | Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853  [€0.09 Mon to Fri:9am - épm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
Italy Anovo ltaly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - épm
Netherlands Ecare +31 0900 0400 063 |€0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - épm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq 800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - 5pm

Théng tin lién lac cho khu viec CHAU MY LATINH:

Quéc gia  Trung tam dich vu S6 cham séc khach hang
Brazil 0800-7254101

: Vermont
Argentina 0800 3330 856

Théng tin lién lac & Trung Quéc:

S6 cham séc khach hang
4008 800 008

Quéc gia
China

Trung tam dich vu
PCCW Limited
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Théng tin lién lac cho khu viec TRUNG VA DONG AU:

Quéc gia

Trung tam
dich vu

S6 cham séc khach hang

+37517 217 3386
Belarus N/A IBA +37517 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

+372 6519900(General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71

+36 1 814 8080(General)
Hungary N/A Profi Service +36 1814 8565(For AOC&Philips only)
Kazakhstan N/A Classic Service Ll.c. |+7 727 3097515

+371 67460399
Latvia N/A ServiceNet LV +371 27260399

+370 37 400160(general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 /70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +37517 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Théng tin lién lac cho khu viec NAM MY:

Quéc gia  Trung tam dich vu S6 cham séc khach hang
US.A. EPl-e-center (877) 835-1838
Canada EPl-e-center (800)479-6696
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Théng tin lién lac cho khu virc Chau A TBD/Trung Péng/Chau Phi (APMEA):

S6 cham séc khach

Quoc gia hang Gio hoat dong
Armenia
Azerbaijan _
Georgia Firebird service centre +97 14 8837911 ?g%OThu' 09:00 -
Kyrgyzstan '
Tajikistan
Australia AGOS NETWORK PTY LTD 1300 360 386 ?ggpj” 700am-
Hong Kong: o i
Hong Kong | Company: Smart Pixels Technology | Tel: +852 2619 9639 Mon.~Fri. 9:00am
6:00pm
Macau Ltd. Macau: Sat 9:00am-1:00Bm
Tel: (853)-0800-987 O VP
: Tel: 1 800 425 6396 Mon.~Fri. 9:00am-
India REDINGTON INDIA LTD SMS: PHILIPS to 56677 | 5:30pm
+62-21-4080-9086 Mon.~Thu. 08:30-
Indonesia PT. CORMIC SERVISINDO (Customer Hotline) 12:00; 13:00-17:30
PERKASA +62-8888-01-9086 Fri. 08:30-11:30;
(Customer Hotline) 13:00-17:30
Israel Eastronics LTD 1-800-567000 >un—Thu. 08:00-
18:00
Mon.~Fri. 9:00am-
Korea Alphascan Displays, Inc 1661-5003 5:30pm
Sat. 9:00am-1:00pm
Mon.~Fri. 8:15am-
Malaysia R-Logic Sdn Bhd +603 5102 3336 5:00pm

Sat. 8:30am-12:30am

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-

5:30pm
Pakistan TVONICS Pakistan +92-213-6030100 oun~ Thu. 10:00am-
6:00pm
o EA Global Supply Chain Solutions _ Mon.~Fri.
Philippines Inc. (02) 655-7777; 6359456 =580
G e " Mon.~Fri. 9:00am-
Singapore E@ﬁzzzgfag;;egitfg (Philips (65) 6882 3966 6:00pm
Sat. 9:00am-1:00pm
South Africa | Computer Repair Technologi 011 262 3586 Hon.= Fri.
ou rica omputer Repair Technologies 08:00am~05:00pm
Taiwan FETEC.CO 0800-231-099 :48‘?&')~F'”" 07:00 -
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7. Dich vu cham séc khach hang va bao hanh
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8. Khac phuc sw co &
Hoi Dap

8.1 Khac phuc sw cb

Trang nay gidi quyét cac sy cb vén ngudi
dung cé thé khac phuc. Néu sy ¢b van
tiép dién sau khi ban da thr dung cac giai
phap trén trang nay, hay lién hé voi dai
dién dich vu khach hang cta Philips.

El Cac sw cb thwong gap

Khéng cé hinh anh (Pén LED nguén

khéng sang)

+ Dam bao da cam day nguon vao 6
cam dién va mat sau ciia man hinh.

«  Trwdec tién, d@m bao nut nguén &
mat trwd'c man hinh nam & vi tri OFF
(TAT), sau d6 day nut sang vi tri ON
(BAT).

Khéng cé hinh anh (Pén LED nguén

sang trang)

«  Dam bao da bat may tinh.

«  Pam bao cap tin hiéu da dwoc két nbi
dung cach v&i may tinh cda ban.

. Dém be}o cap man hinh khdng co6 cac
ch,éu cam bi cong trén mat két noi.
Néu co, hay stra hay thay méi cap.

+ C6 thé da bat tinh nang Tiét kiém
nang lwong

Man hinh théng bao

Attention

Check cable connection

« Pam bao cap man hinh da duoc két
ndi dung cach vé&i may tinh cua ban.
(Cling tham khao Hwdng dan khéi
ddng nhanh).
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«  Kiém tra xem cap man hinh cé céc
chau cam bi cong hay khong.

« Dam bao da bat may tinh.

Nut AUTO (Tw dong) khéng hoat déng

« Churc ndng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban c6 thé thuc hién cac
diéu chinh tha cong qua menu OSD
(hién thj trén man hinh).

& Ghicha

Chtrc nang Auto (Tw ddng) khdéng ap
dung & ché do DIV-Digital (DVI-KTS) vi né
khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

» Khong thuc hién bat ky buoc khac
phuc sy cb nao

« Ngét ngay két ndi man hinh khai 6
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang cua Philips.

E Cac sw ¢ hinh anh

Hinh anh khéng nam giira tdm man hinh

*  Chinh vi tri hinh anh qua chtrc néng
“‘Auto” (Tw déng) trong cac nut diéu
khién chinh trén menu OSD.

« Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/bdng hd) cliia Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi c6 hiéu lwc &
ché do VGA.

Hinh anh rung Ién trén man hinh

. Ki’ém tra xem cap tin hiéu da dwoc
cém chat duang cach vao bang mach
do hoa hay may tinh hay chuwa.

Hién thi hién twong chap chén doc

-
-
-
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» Chinh hinh anh qua chc nang “Auto
(Tw ddng)” trong cac nut diéu khién
chinh ciia menu OSD.

* Loai bd cac vach doc qua Phase/
Clock (Goc pha/Bdng hd) cuia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwe & ché do VGA.

Hién thi hién twong chap chén ngang

=

W)

* Chinh hinh anh qua chtrc nang “Auto
(Tw doéng)” trong cac nut diéu khién
chinh cia menu OSD.

* Loai bd cac vach doc qua Phase/
Clock (Géc pha/Bdng hd) cuia Setup
(Cai dat) trong cac nut diéu khién
chinh ctiia menu OSD. N6 chi co hiéu
lwc & ché d6 VGA.

Hinh anh hién thi nhoe, khéng ré hoic

qua mo

* Chinh d6 twong phan va dd sang trén
menu Hién thi trén man hinh (OSD).

“w2 ”» 1]

Hién twong “anh ao , énh,thl]’ néng”
hay “anh bong ma” van hién thj sau khi
da tat nguon.

« Hién thij lién tuc cac anh tinh trong mo6t
thdi gian dai c6 thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh bong ma” 14 hién twong phd
bién trong cdng nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh thir ndng” hoac “anh ao”
hay “anh bong ma” sé& dan dan bién
mat sau mot thdi gian man hinh bj
ngat dién.

* Luon bat trinh bao vé man hinh
chuyén ddng khi ban khéng st dung
man hinh.
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* Ludn bat &rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cla ban sé hién thj nhirng ndi dung
tinh khéng thay dbi.

« Khéng thé kich hoat trinh bao vé
man hinh hoac ng dung nap lai man
hinh dinh ky c6 thé gay ra cac sw cb
nghiém trong nhw “thtr ndng” hoac
“adnh sau” hoac “anh bong ma” vén
sé khong biét mét va ciing khoéng thé
khac phuc. Thiét hai nhw trén khdéng
nam trong chinh sach bao hanh cla
chung téi.

Hinh hién thi bién dang. Van ban bi m&

hoac nhoe.

» Cai do phan giai man hinh may tinh
sang cung ché do voi dd phan giai
man hinh gbc khuyé&n dung ctia man
hinh LCD.

Cac cham luc, dé, lam, den va trang

hién thi trén man hinh

« Cac chdm con lai 1a dac tinh théng
thwéng clia man hinh tinh thé 16ng
dung trong cong nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém théng tin.

DPén “bat ngudn” qua sang va gay choi

mat

»  Ban cd thé chinh dén “bat nguon” qua
Cai dat dén LED ngudn trong cac nut
diéu khién chinh ctia menu OSD.

Pé duwoc tro giup thém, hay xem danh

sach Trung tam thong tin khach hang

va lién hé v&i dai dién dich vu cham séc

khach hang cta Philips.



8.2
H1.

Dap:

H2.

Dap:

Hoi dap SmartControl Lite

T6i da déi man hinh trén PC sang
man hinh khac va khéng thé st
dung SmartControl, toi can lam gi?
Hay kh&i dong lai PC va kiém tra
xem SmartControl Lite c6 hoat déng
khoéng. Néu khéng, ban can phai g&
bo va cai dat lai SmartControl Lite dé
dam bao cai dat driver thich hop.

Cac chirc nang SmartControl Lite
da hoat déng tét trwéc d6, nhwng
gi® n6é khong hoat ddng nira, toi
c6 thé lam gi?

Néu da thwe hién cac thao tac sau,
thi ban can phai cai dat lai driver man
hinh.

« Da ddi bo thich (rng db hoa video
sang mét adapter khac

* Da cap nhat driver video

* Cac hoat dong trén HPH nhw gbi hoac
loat yng dung

* Chay Cap nhat Windows va cap nhat
man hinh va/hoac driver video

» Da khoi dong Windows bang nut tat
hay ngat két n6i man hinh.

« P& xac dinh sw ¢, hay click chudt
phai My Computer (May tinh cua t6i)
va click vao Properties (Thuéc tinh)-
>Hardware (Phan cirng)-> Device
Manager (Quan ly thiét bi).

+ Néu nhin thay “Plug and Play Monitor”
(Man hinh cdm vao la chay) hién
thi trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bd
SmartControl Lite va cai dat lai.

H3.

Dap:

Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl
Lite, khdng cé muc nao bat Ién
sau mét lat hoac théng bao 16i
hién thi, diéu gi da xay ra?

C6 thé 1a do bd thich (rng db hoa cla
ban khéng twong thich voi (’ng dung
SmartControl Lite. Néu b thich trng
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H4.

Pap:

HS5.

dd hoa la mét trong sb cac nguyén
nhan néu trén, thir tai vé driver bd
thich (rng d6 hoa m&i nhéat tlr website
cua cac cong ty twong rng.

Cai dat driver. G6 bé SmartControl
Lite va cai dat lai mot 1an niva.

Néu né van khéng hoat dong, thi

rat tiéc 1a bd twong &ng d6 hoa
khéng dwoc ho tro. Vui ldng truy cap
website ctia Philips va kiém tra xem
driver SmartControl Lite m&i nhat d3
c6 san hay chua.

Khi t6i click vao Product Information
(Théng tin san pham), né chi hién
thi mot phan, diéu gi da xay ra?
C6 thé 1a do driver bd thich (rng dd
hoa cua ban khéng phai la phién
ban cap nhat méi nhéat vén hd tro
day du giao dién DDC/CI. Hay tho
tai vé driver bd thich (rng dd hoa
m&i nhét tlr website clia cac cong
ty twong rng. Cai dat driver. GO bd
SmartControl Lite va cai dat lai mo6t
lan niva.

Attention

Theft Deterrence is Enabled

T6i da quén ma PIN cho chirc
nang Theft Deterrence (Chong
trdm). Téi can lam gi?

DPap: Trung tdm dich vu Philips c6 quyén

yéu cau xac nhan va quyén hop lé
dé thiét lap quyén s& hiru man hinh.
Xin lwu y chirc ndng chbng trém
dwoc cung cap nhw 1a thy chon tién
ich mién phi. Quan ly ma PIN 1a
trach nhiém riéng cia ngudi dung
ca nhan hay té chirc vén da tao ra
ma nay. Trong tredng hop quén ma
PIN, trung tdm dich vu Philips c6 thé
tao lai cho ban v&i mirc phi nhd sau
khi x4c nhan quyén s& hiru ctia ban.
Xin lwu y chirc nang nay khéng dwoc
bao gébm trong cac diéu khoan bao
hanh chinh thirc.



8.3 Hoi bap chung

H1: Khi cai cai dat man hinh, téi can lam

gi néu man hinh hién thj "Cannot

display this video mode" (Khong

thé hién thi ché dé video nay)?

Pap: Do phan giai khuyén dung cho man
hinh nay la: 1920x1080@60Hz

« Ngat tat ca cac cap roi két néi PC v&i
man hinh ma ban da dung truwdc do.

+ Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang dieu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang dieu
khién man hinh), chon thé "Settings"
(Cai dat). Trong thé cai dat, trong 6
co tén 'desktop area’ (ving man hinh
nén), chuyén thanh truwgt sang muarc
1920x1080 pixels.

+ M& thé "Advanced Properties" (Thudc
tinh ndng cao) va cai Refresh Rate
(Mc nap lai) sang 60Hz rdi click vao
OK.

* Khai déng lai may tinh va lap lai
budc 2 va 3 dé kiém tra xem PC
cla ban da dwoc cai sang mirc
1920%x1080@60Hz hay chuwa.

« Tat may tinh, ngét két ndi man hinh
cii va két néi lai man hinh LCD Philips
cla ban.

«  T&t man hinh rdi bat lai PC.

H2: Mdrc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Mcrc cap nhat khuyén dung cho man
hinh LCD la 60Hz; néu c6 bat ct
hién twong nhiéu ndo trén man hinh,
ban c6 thé cai dat mirc nay sang
75Hz dé kiém tra xem md&c méi nay
c6 loai bo dwoe hién twong nhiéu
hay khong.

Dap:
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H3: Cac file .inf va .icm trén dia CD
la gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Dap:bay la cac file driver cho man hinh
clia ban. Thyc hién theo cac chi dan
trong sb tay st dung dé cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hoac 1ap dia driver khi ban
cai dat man hinh Ian dau. Thwc hién
theo cac chi dan dé I&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat tw dong.

H4.:
Pap:

Lam thé nao dé chinh dé phan giai?
Card video/driver dé hoa cta ban

va man hinh sé cling quyét dinh

cac do phan gidi c6 sén. Ban co thé
chon dé phan giai mong mubdn trong
Control Panel (Bang diéu khién)

cua Windows® qua thé “Display
properties (Thudc tinh man hinh)”.

H5: Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK, rdi chon 'Reset'
(Cai dat lai) dé cai dat tat ca tré vé
cai dat mac dinh gbc.

Pap:

H6: Man hinh LCD c6 kha ning chéng
tray xwéc?

N6i chung ban khéng nén dé bé mat
man hinh va cham qua murc véi cac
vat khac hay va bao vé né khéi cac
vat dung sac hay cun. Khi cdm man
hinh, dam bao khéng dung strc ép
hay lwc manh |&én phia bé mat man
hinh. Diéu nay c6 thé anh hwéng dén
cac diéu kién bao hanh cla ban.

Dap:

T6i nén lau man hinh LCD nhw thé
nao?

Dé lau thong thwdng, hay stir dung
khan sach va mém. Dé lau k¥, hay
dung con isopropyl. Khéng dung

cac dung méi khac nhu cén étylic,
ethanol, axeton, hexan, v.v...

H7:

Dap:



H8: Toi c6 thé thay déi cai dit mau sac
cho man hinh?

Dap: D7 nhién, ban c6 thé thay déi cai
dat mau sac qua nut diéu khién trén
menu OSD theo cac quy trinh sau,

« Nhan “OK” dé hién thi menu OSD
(Hién thj trén man hinh)

« Nhéan "Down Arrow" (Miii tén xudng)
dé chon tay chon "Color" (Mau) roi
nhan "OK" dé vao cai dat mau; cé ba
lwa chon mau nhw sau.

1. Color Temperature (Nhiét dé mau):
V@i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng,
v&i tin hiéu mau dé-trang", trong
khi nhiét d6 9300K tao ra “tin hiéu
mat lam-trang’.

2. sRGB (P&-Luc-Lam chuén): day
la cai dat chuan dé dam bao trao
d6i mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Ty chon): ngw®i dung
co thé tw chon cai dat mau sic wu
tién bang cach chinh mau d, luc
va lam.

& Ghichu

Do mau anh sang tdéa ra tir mét vat dung
trong khi n6é dwoc lam néng. Sé do nay
duwoc thé hién dwa trén ty 1& tuyét dbi, (murc
dé Kelvin). Cac mirc nhiét dé Kevin thép
hon nhw 2004K la mau do; cac mdrc nhiét
dd cao hon nhw 9300K Ia mau lam. Nhiét
do trung tinh la mau trdng & mirc 6504K.

H9: Tbi c6 thé két ndi man hinh LCD véi
moi PC, may chu hay may Mac?

Co thé. Tat ca cac man hinh LCD
Philips déu hoan toan twong thich
véi cac PC, may Mac va may chu
chuan. Ban c6 thé can cé dau ndi
cap dé két néi man hinh méi hé
théng may Mac. Vui long lién hé voi
nhan vién kinh doanh cda Philips dé
biét thém thong tin.

Dap:
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H10: Man hinh LCD Philips c6 hé tro
chuan Plug-and-Play (Cam vao la
phat)?

Cé, cac man hinh Philips déu hb tro
chuén Plug-and-Play twong thich vé&i
Windows 8/7/Vista/XP/NT, Mac OSX,
Linux

bap:

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

- Hién thi lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong "anh thir néng", con dwoc goi
la “anh ao” hay “anh béng ma”, trén
man hinh cla ban. “Anh thir néng”,
“Anh 40" hay “Anh béng ma” 14 hién
twong phd bién trong cong nghé man
hinh LCD. Trong moi trwvdng hop,
hién twgng “anh thir nédng” hay “anh
40” hay “anh bong ma” sé bién mét
dan trong mét thdi gian sau khi da tat
ngudn.

Ludn bat trinh bdo vé man hinh
chuyén déng khi ban khéng str dung
man hinh.

Ludn bat yng dung lam mé&i man
hinh dinh ky, néu khéng, man hinh
LCD cta ban sé hién thj nhirng noi
dung tinh khéng thay dbi.

¢ Canh bao

Cac hién twong “anh thir néng” hay “anh
40” hay “anh bong ma” sé khéng biét mat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
bao hanh cla chung toi.

H12: Tai sao man hinh cua téi hién thi
van ban sac nét va cac ky tw rang
cwa?

Pap: Man hinh LCD cua ban hoat
dong tét nhat & dd phan giai gbc
1920x1080@60Hz. P& man hinh
hién thi tt nhat, vui ldng st dung do
phan giai nay.



84 MHL FAQs

H1: T6i khong thé xem hinh anh tw

thiét bi di dong trén man hinh

Pap:

« Hay kiém tra xem thiét bj di dong cla
ban c6 dwgc chirng nhan twong thich
MHL hay khéng.

« Ban ciing can cé cap dwoc chirng
nhan twong thich MHL dé két ndi cac
thiét bi.

«  Dam bao ban da két ndi v&i cong
MHL-HDMI, va da chon dau vao thich
hop trén man hinh qua bd chon dau
vao (mat vat trwdc hoac menu OSD
{hién thi trén man hinh})

« San pham duwoc chinh thirc cong nhan
twong thich MHL. Vi day la man hinh
kh(‘)ng ngu(),n, r]én neu ban gap phai
b‘ét ky sw cO bat ng& nao khi st dqu
dau vao MHL, \{ui long tham khao so
tay st dung thiét b| di dﬁmg hoac lién
hé v&i nha san xuat thiét bi di dong
do.

Attention

No video input(MHL-HDMI)

«  Dam bao thiét bi di ddong ctia ban
chwa vao ché dd ch& (khéng hoat
dong). Néu da vao ché do nay, thi ban
s& nhin thay thédng bao hién thj trén
man hinh. Mot khi thiét bj di ddng hoat
dodng lai, man hinh cling sé hoat déng
va hién thj cac hinh anh. Ban co6 thé
can dam bao da chon dau vao thich
hop néu da sir dung hodc két ndi voi
béat ky thiét bj nao khac

H2. Tai sao hinh anh hién thi trén man
hinh c6 chat lwgng kém? Thiét bi di
dong cua téi nhin cé vé tét hon nhiéu.

Pap:
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« Chuén MHL dinh rd théng s& 1080p
@30hz cb dinh cho du ra va dau
vao. Man hinh twong thich véi chuan
nay. Chéat lwong hinh anh tuy thudc
vao chét lwgng cla cac ndi dung gbc.

« Néu néi dung c6 dd phan dai cao (vi
du nhw HD hoac 1080p), thi n6 sé
hién thi & dang HD hoac 1080p trén
man hinh nay. Néu néi dung gbc c6
dod phan giai thip (vi du nhu QVGA),
thi né c6 thé nhin cé vé tét hon trén
thiét bj di ddng do c& man hinh nhd,
nhwng sé& nhin c6 vé kém chét lwong
hon trén man hinh I&n nay.

H3. T6i khong thé nghe am thanh tir
man hinh.

Dap:

«  DPam bao han hinh cta ban c6 cac loa
tich hop va am lwong dwoc bat trén
canh man hinh cling nhw trén canh
thiét bj di dong. Ban ciing c6 thé st
dung cac tai nghe tuy chon.

« Né&u man hinh khéng cé cac loa tich
hop, thi ban cé thé cdm céc tai nghe
tuy chon vao dau ra trén man hinh.
Vui long dam bao da bat am lwong
trén canh man hinh ciing nhw trén
canh thiét bj di dong.

Dé c6 thém théng tin hodc cau hoéi

thwong gap (FAQ), vui long truy cap

trang web chinh thirc cua tap doan

MHL.:

http://www.mhlconsortium.org
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